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The Ribbon Menu of Microsoft Word  
 
2007  

 
Figure 1:  Word 2007 Ribbon Menu 
 
2010 

 
Figure 2:  Word 2010 Ribbon Menu 
 
The Ribbon structure is very similar in the two latest versions of Word (2007 and 2010).  
The only obvious difference is the Office button which is replaced by the File tab in 
2010. The illustration below identifies the features of the Ribbon structure. 
 

 
Figure 3:  Componets of the Ribbon Menu on Word 2007 
 

 

 
 



The Drawing Tools for Tactile Graphic Production 
 

Repositioning the Quick Access Tool Bar 

 
Figure 4: Quick Access Launch Arrow Pulldown Menu 
 
 
• The Quick Access Tool Bar  default display position is next to the Office button 

(2007) or next to the "W" logo in 2010. 
 

• Select the pull down arrow just to the right of the Quick Access Tool Bar. 
 

• A "Customize Quick Access Toolbar" menu list is activated. 
 

• Select "Show Below the Ribbon." 
 
 
 
The Quick Access Tool Bar is will reposition below the Ribbon. The purpose of doing 
this is to create more display room for additional drawing tools.  It is easier to find the 
drawing tools if they are located below the Ribbon. 

 
Figure 5:  Quick Access Tool Bar with Drawing Tool Installed. 

Drawing Tools Needed on the Quick Access Toolbar 
 

1. Grid Setting :   Configuration Dialog Window for the grid guidelines. 
2. View Gridlines : Activates/deactivates the grid guidelines on the document. 
3. Shapes : Includes lines, arrows, geometric shapes, and unique shapes. 
4. Group Tool:   Mends a set of objects into one object. 
5. Ungroup Tool:   Breaks an object into separate individual objects. 
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6. Shapes Fill :  Fills the selected object with a color, gradient, picture or pattern. 
7. Shapes Outline:   Specifies the color, width, and line style of a selected shape. 
8. Dashes Tool:   Provides a choice of lines for drawing. 
9. Arrows:   Provide a choice of types and directionality of arrows lines.  
10. Outline Weight Tool:  Provides a choice of line and border thickness. 
11. Rotate Tool:   Rotates or flips a selected object. 
12. Send Backwards Tool:  Sends the selected object behind all other objects. 
13. Forward Tool:   (optional) Moves a selection one object layer forward. 
14. Horizontal Text Box Tool:   Inserts a textbox into a document. 
15. Picture Size:   Resizes graphs that will keep the aspect ratio (prevents 

distortion). 

Adding Tools to the Quick Access Toolbar  

 
Figure 6:  "More Commands"  item is highlighted in the Quick Access pulldown menu. 
 
To add drawing tools to the Quick Access tool bar you have to go to the "Customize" 
section in the "Word Options" dialog window.   
 
Here is the pathway to reach that section: 
 
• Select the pull down arrow just to the right of the tool items on the Quick Access 

Tool Bar. 
 

• Choose "More Commands….." from the list of items in the "Customize Quick Access 
Toolbar" submenu. 

 
 



 
 
 
 
 

The "Word Options"  Dialog Window:  Customize Secti on 

 
Figure 7:  The "Customize the Quick Access Toolbar"  Window 
 

1. Select "Customize" from the list of items located in the left side pane. 
 

2. From "Choose commands from…" pull down arrow find "Drawing Tools | 
Format Tab" from the field list. 

 
3. Select a tool in the listing. 

 
4. Select "Add." 

 
5. The tool should appear in the Quick Access Toolbar list. 

Categories of Tools Menu 
• Tools are categorized in groups. 
• The “Drawing Tools” category contains the Word drawing tools.  
• Text boxes are located in the “Text Box Tools” 
• Be sure to press “OK” after uploading is complete. 
• Tools in this list will now appear in the Quick Access Toolbar on the Ribbon. 
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Drawing Tools Needed for Tactile Graphic Production  
• “Zoom” tool 
• “Group” (mending objects together) 
• Grid Line Display 
• “Undo” keystroke (Ctrl+z) 
• Duplicate keystroke (Ctrl+d) 
• Copy keystroke (Ctrl+c) 
• Paste keystroke (Ctrl+v) 
• Cut keystroke (Ctrl+x) 
• Drawing Area (only in MS Word ) 
• Order (arranging object from front to back) 
• “Select Objects” arrow 

 

 
Figure 8:  Components of a Word 2007 Document 
 
Location of Tools on a Word 2007 Document 
 

1. Paste and Paste Special 
2. Font Type and Size 
3. Drawing Tools on the Quick Access Toolbar 
4. Object Select Arrow 
5. Zoom 



 

Configuring the Drawing Area of a Word Document 
 

Opening the “Drawing Grid” configuration window 
 

Select the “Grid Setting” icon that now is located in the Quick Access Toolbar.   
 
 
The “Drawing Grid” dialog window is now activated.  
 

 
 Figure 9:  Drawing Grid window is activated. 

 
This window contains all configuration elements for displaying grid guidelines on 
a Word document. 
 
The grid guidelines are helpful when drawing straight line illustrations that are 
often needed in tactile graphics particularly in math and science. 
 



Grid Setting for Tactile Graphic Production 

 
Figure 10:  Setting for the Drawing Grid Dialog Window 

 
 
1. Uncheck the “Snap object to…..” 

 
2. Set Grid setting to 0.5” on both horizontal and vertical spacing. 

 
3. Uncheck “Use margins" and set margins to about 0”. 

 
4. Check “Display gridlines on….. 

 
5. Set “Vertical” and “Horizontal” every set to 1. 

 
6. Press OK. 
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Grid Guidelines Configuration on a Word 2007 Docume nt 

 
Figure 11:  Word Document with Grid Guideline Visable 
 

 
Grid lines should be equally spaced at .5 inches. 
 
Both vertical and horizontal lines are displayed. 
 
The grid lines will not print on a regular printer nor a Tiger embosser. 
 
Grid lines extend to the sides and both top and bottom of the document.  

 
Line and object drawings will snap to a grid guideline when the grid is displayed. 
 

An Important Note: 
If you are using Windows 7 with Word 2010,  save th e blank document now as a 
.doc because selecting all objects with the groupin g tool selection arrow will not 
work in a .docx (xml) document.  

 

 
 



 

Drawing an Object on the Document 
 

Selecting an Object from the Shapes Tool 

 
Figure 12:  Shape Pulldown Menu 

 
 

• In the Quick Access Toolbar select the “Shapes” icon.  
 

• Select the arrow line tool icon.  
 

• All lines arrows and other objects for drawing are located in the “Shapes” pull 
down menu. 

 
 
  
 
 
 
 



Draw, Duplicate, Rotate, and Move an Object 
In this section an object (arrow line) is drawn.  This object is duplicated.  The duplicated 
object is then rotated 90 degrees and moved into a preferred place on the document. 
 

Draw the Object: 
 

 
Figure 13:  Drawing a Vertical Line 
 

• Place the Drawing cursor at a guideline intersection (1). 
• Hold the left mouse button down. 
• Drag mouse cursor  from bottom to top (2). 
• Release at the preferred end point. 

Duplicate the Object: 
 

 
Figure 14:  Duplicating a Vertical Line 

 
• Select the original object 



• Press the key combination command Ctrl+D  to duplicate the arrow. 
• The duplicated object becomes the highlighted (active object for interaction). 

Rotate the Object: 

 
Figure 15: Rotating a Vertical Arrow Line 90-degrees to the Right. 
 
 

• Make sure the object is highlighted (selected). 
 

• Select the “Rotate” icon in the Quick Access Toolbar. 
 

• Select “Rotate Right 90 degrees” 
 
 
 
 
 
 
 
 
 



Move the Object: 

 
Figure 16: Nudging an Arrow Line into Position 
 
 
Objects are moved in one of two ways. 
 

1. Mouse (left button and dragging). 
2. Keys (directional arrow keys). 

 
 
Use the directional arrow keys (left/right) when fine tuning into a preferred placement.  
This is called "nudging." 
 
 
 

Grouping the Objects into One Object 
Objects on the document can be "mended" together into one object.  The main reason 
for doing this procedure is to be able to move a group of vector graphics as one object.  
If they are grouped together as one object, all lines, textboxes, shapes, etc. will move as 
one object.   
 
Remember to save the document as a .doc if you are using Windows 7 with Word 2010.  A 

.docx file disables the selection arrow tool. 

 

 
 
 



Locating the Selection Arrow: 
  

 
Figure 16:  Locating the "Select" Arrow on the Ribbon Menu 
 
The selection arrow is needed to select (highlight) the objects for grouping. 
 
• In the "Home" tab locate the "Editing" category. 
• Choose "Select" from the “Editing” pull down arrow menu. 
• Choose "Select Objects" from the “Select” pull down menu. 
• The cursor turns into a white selection arrow. 

 

Selecting More Than One Object 

 
Figure 17: Illustration of Selecting More Than One Object at a Time 
 
• Place the Select arrow cursor above all objects included in the selection. 
• Hold the left mouse button down. 
• Drag across all the objects that you want selected. 
• The selection marquee (dashed lined rectangle) should include all objects in the 

selected area. 



 
 
 
 

Grouping the Selected Objects 
 

 
Figure 18: Indicating where the "Group" tool is located on the Quick Access Toolbar 
 
• Choose the “Group” icon located in the Quick Access Toolbar. 
• Clicking on this icon will mend the objects included in the selection marquee into one 

object. 
 
 

 
Figure 19:  Illustration of a xy axis lines. 

 
• Now the objects mended together becomes one object. 
• It can now move as one object either by the arrow keys or the mouse. 

 



The illustration is the XY axis arrow lines of a Cartesian coordinate plane.  This 
illustration needs the coordinate lines.  Production of the coordinate lines, both x and y, 
are drawn and manipulated using similar tools and methods offered by the drawing 
features.   
 

Drawing Precision Illustrations on a Tactile Graphi c: 
 
Precision drawing on a Word document requires the use of many of the drawing tools 
like: the zoom features, nudging with the directional arrow keys, rotation, duplication, 
and grouping.  The coordinate lines on a Cartesian coordinate plane are lines of equal x 
and y distance.  They require some precision and consistency in order for the illustration 
to best represent the information, especially in math and science. 
 
The coordinate line procedure below will include the lines of equal distance and a tick 
marker for each integer point on the coordinate plane.   

 
Figure 20:  Indicating the space between the vertical axis line to the grid guideline 
 

Moving an Object with the Directional Arrows 
 
Nudging with the Arrow Keys: 
• Select the object by clicking anywhere on the lines with the "Select Objects" arrow. 
• Hold down the Control key. 
• With the Control key pressed, nudge the object to the right with the right arrow key. 
 
Because the object is snapped to the grid lines when the grid lines are displayed, using 

the control key with the arrow keys "releases" the object from the closest grid line. 
 
 



The area indicated by "A" will be the width of the tick line (the number indicator points) 
on the y axis.  

Selecting the Drawing Tool 

 
Figure 21:  Highlighting the line tool location in the Shapes pulldown menu 
 

1. Select the “Shapes” icon in the Quick Access Toolbar. 
2. Select the “Line” icon in the Lines category. 
3. The arrow cursor changes into a crosshair drawing cursor. 

 
When the cursor changes into the crosshair, it is in the drawing mode. 
 

Drawing a Line 

 
Figure 22:  Indicate how a line is drawn on the guidelines 
   

• Place the drawing cursor on a guideline intersection just to the left of the vertical (y-
axis) arrow line (1). 

• Press and hold down the left mouse button. 
• Drag the mouse from left to right (2). 
• Release the left mouse button at the preferred end point (3). 



 
Figure 23:  Indicates how lines are duplicated  on the guidelines 

Duplicating the Object 
 
• Press the key combination command: Ctrl+D to duplicate. 
• Duplicate once then nudge the object into the appropriate position. 
• Further duplication will produce objects into place automatically (not always 

accurate). 
 
 

 
Figure 24:  Indicating the tick lines and the coordinate plane lines without the guideline visible. 

 
Unchecking the "View Gridline" box makes the the gridlines disappear.   
 
Not having the gridlines displayed makes it easier to find the objects (coordinate lines) 
to select for grouping. 
 
A is located near the number point indictor (tick or hash marker). 
 
B is on a coordinate line. 
 

A 

B 



 

 
Figure 25:  Indicating how selecting several objects are selected for grouping together. 

Selecting  and Grouping all Objects into One Object  
 

1. Choose the Select Arrow in the “Editing” section in the “Home” tab on the Ribbon 
menu. 

2. Place the Select Arrow just above and to the left of all objects need to be 
selected (1). 

3. Press and hold down the left mouse button. 
4. Drag mouse cursor (Select Arrow) diagonally down to the right lower corner (2). 
5. Be sure to include all objects within the selection marquee (3). 

 

 
Figure 26:  Highlighting the green "object selected" indicators. 

 
 

• Releasing the mouse button will reveal all objects included in the selection. 
• The green dots or blue square markers indicates that objects have been selected.  



 
 
 

 
Figure 27:  Indicating the "Group" tools in the Quick Access Toolbar with "Group" selected in the pulldown menu. 
 
• Select the “Group” icon on the Quick Access toolbar. 
• Select “Group” from the menu. 
• Objects are mended together as one object. 
 
 

 
Figure 28:  Indicating a graph with axis arrow lines and y coordinate lines. 
 

 
• The objects mended together are now one object. 
• It can move in the document as one object. 

 
 
 
 
 



Reset the Illustration Back on the Grid Guidelines 
 

Displaying the Gridlines 
  

 
Figure 29:  Highlighting the "View Guideline"  checkbox in the Quick Access Toolbar 
 
• Check the “View Gridlines” to display the grid guidelines. 
• Object will snap to the grid guidelines. 

Repositioning the Object 
 

 
Figure 30:  Indicating the coordinate plane reposition to different guidelines 

 
• Nudge the object back to the grid guideline by using the arrow keys. 
• Coordinate lines and axis lines are now realigned to the grid guidelines. 

 



You may have to press the arrow keys several times to get the y-axis line to "snap" to a 
guideline.  
Once the axis line is lined to a guideline, the object will move from guideline to another 
guideline when pressing the directional arrow keys. 
 
Once the illustration is on the guidelines, the same process that made the y axis 
coordinate lines can be used to make the x axis coordinate lines. 
 

Here is a summary outline of the procedure for maki ng the x axis 
coordinate lines. 

Nudging the Object:: 
By pressing the key combination command:  Ctrl + Up Arrow , nudge the object to 
create a space between the horizontal arrow line and a grid guideline. 

Selecting the Line Drawing Tool:   
o Select the “Shapes” icon on the Quick Access Toolbar. 
o Select “Line” in the “Lines” category. 
o The arrow cursor will change into a drawing crosshair cursor. 

Position the Drawing Cursor:   
o Set the cursor on an intersection of grid guidelines below the x axis line. 

Drawing A Line 
o Press and hold the shift key down. 
o Press and hold the left mouse button down. 
o Drag the mouse from bottom to top to draw a line. 

Duplicating A Line 
o Select an object to be duplicated. 
o Press the key combination command: Ctrl + D  to duplicate an object that has 

been selected 

Snapping an Object to the Grid Guidelines 
o Be sure that the object for repositioning is selected. 
o Use the arrow keys to reposition a selected object to snap it to the grid 

guidelines. 

Repeat Duplication 
o Keep pressing Ctrl +D  to continue duplicating the object. 
o Once the first duplicated object is trained to the grid guideline, repeat 

duplication of the object will try to “guess” the next position.  
o Sometimes the guess is correctly. 



Selecting All Objects 
o Choose “Select Arrow” in the “Editing” section in the “Home” tab on the 

Ribbon menu. 
o Place the “Select Arrow” icon just above and to the left of all objects.  
o Press and hold down the left mouse button. 
o Drag mouse cursor (Select Arrow) diagonally down to the right lower corner. 
o Be sure to include all objects within the selection marque. 

Grouping 
o Select the “Group” icon on the Quick Access Toolbar. 
o Select “Group” from the menu. 
o Objects are mended together as one object. 
 

The Completed Illustration (without labels) 
 

 

 
Figure 31:  Indicates the coordinate plane with all axis and coordinate lines. 

 
• Objects are now one object (Cartesian coordinate plane). 
• It can be moved to any area of the document easily as one object. 
• It is now ready for the secondary drawings. 
• It is also ready for labeling. 

 
 
There are only three line weights that the Tiger em bossers recognize :   
thin, medium and thick.  Word 2007and 2010 equivalent number weights are: thin (1/4-
11/2), medium (2-3), and thick (41/2-6).   



The xy arrow lines are the middle weight lines (2-3) 
The coordinate lines are the thin weight lines (.25-1.5) 
The equation lines are the thick weight lines (4.5-6) 

Labeling the Tactile Graphic 

Some Guidelines: 
• Use the BANA standards as much as possible. 
• Do not clutter with too much information. 
• Titles are always above graphics. 
• Legends need to be on separate pages. 
• Use only graphics and labels that best represent the answers to questions. 
• 24 point size is used for PIAF and TIE production 
• 28 point size is used for Tiger embossers. 

Direct Input Translation 
• Text is typed in using computer Braille or ASCII for contracted Braille characters. 
• Doing it this way does not require extra software. 
• Braille fonts need to be uploaded on your computer. 

ASCII Labeling Equivalent 

 
Figure 32:  Braille  ASCII Chart 



 
For example if the symbol “%” is typed in the document, when the font is changed to a 
braille font,  it becomes the “sh” contraction.  
 
You would need to have a braille font uploaded on the computer in order to perform the 
changes.  Braille fonts can be down loaded from www.tsbvi.edu/Education/fonts.html 
(on the old website)  or www.tsbvi.edu/braille-resources/1087-download-braille-and-asl-
specialty-fonts (on the new website) 

Downloaded Braille Fonts from the TSBVI website 
 

 
Figure 33:  Indicates the braille font files: Braile Kiama, Braille, and RNIB Braille. 
 
 

1. Zip files  downloaded from TSBVI website 
2. File  extracted from the zip file 
3. Text information  about files when extracted from the zip file 

 
 
 
 
 
 
 
 



Where to Upload Braille Fonts 

Open “My Computer”  

 
Figure 34:  Indicates the location of "My Computer" in the Start menu 
 
• Open the “Start” menu. 
• Select “My Computer”. 
 

 
Figure 35:  Indicates the location of the "Local Disk (C)" in Windows Explorer 

Open “Local Disk (C:) 
 
• Locate in the “Hard Disk Drives” , 
• Double click to open or select icon and press “Enter”. 

 
 



 

Open “Windows” folder 
 

 
Figure 35:  Indicates the location of the "Windows" folder in the C drive. 
 
• Locate the  “Windows” folder. 
• Open file by double clicking on it. 
 

Open “Fonts” folder 
 

 
Figure 36:  Indicates the location of the "Font" folder in the "Windows" folder. 



 
• Locate the “Fonts” folder. 
• Open by double clicking or selecting it and press “Enter”. 

 

Drag and Drop in “Fonts” folder 

 
Figure 37:  Indicates where the new braille font file  is located in the "Fonts" folder 
 
• The Font folder contains many font files. 
• Drag and drop Braille files into this folder. 
• Close the folder. 
 



Labeling Process on the Graphic 

Reposition the Graph to Label Tick Markers with Num bers 

 
Figure 38:  Indicates the tick number indicators on the x and y axis lines of the coordinate plane. 

 
• Select the graphic. 
• Nudge the graphic off the grid guideline by pressing the key combination command: 

Ctrl+ Arrow Key(s). 
• The tick lines should have a space between them and the nearest grid guideline 
 

Creating A Text Box 
 

 
Figure 39:  Indicates a drawn text box when selecting the "Draw Text Box" tool. 

 
• Select the “Draw Text Box” icon on the Quick Access Toolbar. 
• Move the cursor anywhere on the document. 
• Press down the left mouse button. 
• A text box will appear with a blinking cursor. 
 
 



Font Setting  
(If not using Braille direct input) 

 
Figure 40:  Displays the Font dialog window 

 
• Courier New 
• Regular style 
• 24point (for encapsulated paper production-TIE and PIAF) 
• 28 point (for Tiger embossing) 

No Fill Text Box 

 
Figure 41:  Indicates the "Shapes Fill" pulldown menu with "No Fill" selected. 

 
• Be sure the textbox is selected (highlighted). 
• Select the “Shape Fill” icon in the Quick Access Toolbar. 
• Select “No Fill” 

 



Text Boxes 
(Transparent -No Fill Background) 

 
Figure 42:  Indicates a textbox with text that is set at typeface Courier New and font size at 29pt. 
 
 
The textbox becomes transparent within the document. 
Any object or grid guideline is visible behind the textbox.  

 

 
 

 

Types of Graphics that include Labels 
 

 
Figure 43:  Indicates a textbox contain the number 1. 
 
• Math Graphs 
• Charts 
• Maps 
• Scientific Graphics 

 
 



Adding Graphics Labels  

 
Figure 44:  Highlighting "View Guideline", the Draw Textbox tool, and a textbox on the layout  area. 
 
• Check “View Gridlines”. 
• Position graphic in the preferred location. 
• Select the “Text Box” icon. 
• Press the left mouse button down when the cursor is on the document. 
• Nudge into position by using the arrow keys 
 
 
 
 
 

Fill Setting for Graphic Labels 

 
 
• Select the text box label. (highlight text box) 
• Select the “Fill Shapes” pull down arrow (to the right of the Fill icon). 
• Select “No Fill”. 
 



 

Duplicating Text Boxes 
 

 
 
• Make sure “View Gridline” is activated 
• Select the text box label. 
• Press Ctrl + D  to duplicate the text box. 
• Nudge in position by using the arrow keys. 
 
 

Repeat Duplication 

 
 

• By nudging a duplicated text box into a preferred position, it will train Word to predict 
the next preferred location. 

• If prediction is correct then keep pressing Ctrl + D  until labeling is complete. 



 

Fine Tuning Graphic 
 

 
 
• Correct all labels. 
• Check to see if spelling and grammar is correct. 
 
 
 
 
 
 
 

Selecting all Text Boxes 

 
 
• Hold down the “Shift” key. 



• Click on each text box label 
• Text boxes will stay selected. 
 

Selecting A Braille Font 

 
 
• Select the pull down arrow to the right of the font type field in the Ribbon menu bar. 
• Select a Braille font. 
• Make sure it is at least 24 point size. 
 

No  Fill Background In Text Boxes 
 

 
 
• Select the pull down arrow just to the right of the "Shape Outline” icon. 
• Choose the “No Outline” option in the list under “Standard Colors” 



 
 

Ready Labels 

 
 

• Text box borders are now removed. 
• Fills are set at “No Fills” 
• Font size is at 24 point. 
• Type font: Braille or Braille Kiama 

Labels Involving Contracted Braille 

 
 
• Text can be entered in directly by using ASCII text. 
• Text can be entered in by cutting, translating and pasting using either Duxbury or 

Braille 2000. 
 

Cutting and Pasting Using Duxbury 
 



 
 

Selecting and Copying Text in Text Box 
• Select the text in the text box. 
• Copy text to clipboard:  Ctrl + C . 
• Open a blank “print” document in Duxbury. 

Duxbury Application Interaction with Text 

 
 
• Paste into a new “Print” document in Duxbury Braille Translation application. 
• Translate the document into Braille (contracted). 
• Select the translated Braille document. 
• Copy to clipboard (Ctrl +C ) 

 
 
 



Pasting New Text into Text Box  

 

 
• Make sure the original text in text box is selected. 
• Replace the old text with the translated text by pasting from clipboard: Ctrl + V . 
• New text will appear in ASCII or computer Braille. 
• Text can now be changed to a Braille font. 

You can do this with all labeling needs even with N emeth code text. 
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